How to Capture Interior Spaces for As-Built Documentation
A Step-by-Step Guide
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Introduction

Mobile 3D scanning is here to stay.

This new technology already has many advantages over traditional surveying methods.
Although still not perfect, if used correctly it will make your job easier and save you a lot of
valuable time.

About this guide

This manual will help you quickly learn how to use an iPad or an iPhone as a 3D scanner to
capture a property accurately, regardless of its size. We'll show you how to prepare, explain the
scanning process step by step, and guide you through the options for processing your scan
and sending it for drafting and reporting work

This guide was created by Mediatask, a drafting and reporting company that
specializes in utilizing cutting-edge reality capture technology combined with
the expertise and talent of our drafting engineers. The content is based on
numerous field tests and feedback from our clients, whom we have assisted in
adopting 3D scanning technology.

Mediatask's offering includes floor plans, CAD & BIM models, area
measurement reports (e.g. NEN2580, ANSI Z765, BOMA), and more.
For more information visit us at mediatask.co.

DotProduct develops high-performance, easy-to-use solutions for capturing 3D
spatial data for documentation of the built and existing world. Our technology is
designed for mobile professionals who need high-quality 3D data, instantly. Our
Dot3D software delivers accurate, mobile 3D scanning capabilities on i0S,
Windows, and Android devices, turning your phones and tablets into versatile
professional-grade 3D-capture and processing solutions.

Learn more about DotProduct and Dot3D at dotproduct3d.com


https://mediatask.co/
https://www.dotproduct3d.com/
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Prep like a Pro

Hardware

You'll need an iPad or iPhone with a LIDAR sensor. If you're unsure if your device has it, look for
a 5mm black circle near the rear cameras or check your specs.

Here's a list of compatible devices:
e AlliPad Pro 4th-generation (2020) and newer
e AlliPhone Pro or Pro Max models, generation 12 or newer

We recommend using an iPad because of the sturdier grip, bigger screen, and better heat
dissipation (scanning is hard work for your device!), but you'll also be able to make a perfect
capture with an iPhone. A gimbal is a good option when scanning with a phone.

A heavy-duty case is a good idea:

You will be walking with your device and moving it around a lot so it's important to have it
well-protected with a robust case with a good grip. A ,pro’ case will also make a good
impression on the client or homeowner.

One caveat
Make sure your case doesn't trap the heat dissipated from the device. If you notice your device

is getting too warm it is better to take the case off. Overheating can slow down performance
but also lead to instability and inaccuracy due to the deformation of the optical elements.
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Tags

To get the most precise results we cannot rely on the device's sensors alone. After all, it's
smart but it's only a phone!
Dot3D recognizes AprilTag targets. For a quick start, you can download and print them on a

regular printer and use painter’s tape to safely attach them to a wall. Make sure not to occlude
the black printed area with the tape.

A sturdier solution: Mediatask provides a starter kit containing 28 targets printed on a lightweight gator board with blue-tack on the
backside for easy mounting on and off the wall. The surface is laminated with a matte finish for durability and good detection at all
viewing angles.

In the “place tags” section we'll show you how to properly set up these tags, use your laser
measure to grab reference dimensions between them, and input them into the app.

Other tools

A laser measure tool will be essential for inputting additional known dimensions, so take your
Disto with you. Versions with the end piece are most recommended as they will allow you to
make even more precise measurements between the centers of the tags even at an angle.

It is handy to have a tape measure, especially when the only option is to measure between
tags placed on the floor.


https://www.dotproduct3d.com/targets.html
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Software

To make the scan you'll need to have Dot3D installed on your device. There are
many apps in the market and we have tested them all. Dot3D is precisely tailored
for your use case: it will be very easy and handy to use with scanning interiors
and the data will be at least as precise as your hand measurements.

The app is constantly improving so make sure you periodically check if you have the latest

version installed.

Checklist

Have your device charged
Cameras and sensors cleaned
Tags

Disto

Tape measure

Turn on ,do not disturb” mode*
Charger and / or power bank

o Dot3D installed

* Receiving a call or clicking on a system
notification will interrupt your scan. Dot3D
enables you to recover it and continue, but we
highly recommend to always turn on the “Do not

disturb” mode on your device before scanning.
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Scanning Step-by-step

1. Plan and prepare your route

This is a crucial step. Go through the entire property to get a sense of space,
and connections between rooms to make a mental map of the space.

Think of it as a test run: try to make yourself aware of the potential obstacles
you will encounter while making the scan.

While making this walk open all doors, if possible in such a way that you won't
need to move them later. If you can, use door stoppers to fix doors in place.
I\ Moving doors during the scan can confuse the algorithm and lead to errors
in 3D reconstruction.

Open some cabinets and fixed wardrobes so that the scan will show the true
depth of a room.

It is a good idea to open window curtains at this point to make sure window edges are visible.

This will make scanning them easier and more precise. While scanning windows remember to
keep your distance - if you get too close the camera will not be able to track its position by the
outside scope alone.

Important!

Plan your route in such a way that you finish your scan in the place you started.

When scanning multi-story buildings we recommend that you:
e Scan the base level, starting at the staircase area, scanning all the rooms, and then
returning to the staircase area
e Walk up the staircase and do the same thing for the 1st floor
e Repeat until all floors are captured,
e Continue the capture while descending the stairs until you reach the starting area
e Make sure to have a fair amount of overlap around the start/end point
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If scanned properly, the staircase will provide a very good connection between the scans of
the different floors. It is very important to place tags on each floor near the staircase and to
capture those tags when doing the loop on each floor and when ascending and descending
the stairs. You'll find more information about tag placement and usage in the next section.
Include exterior spaces and structures (terraces, gardens, sheds, guesthouses, etc.) in the

scan of the ground floor (but remember to close the loop and return to the starting position).

2. Place tags

While preparing the route, strategically place AprilTag targets: make sure to place at least 4
targets on each floor, which will allow you to check two dimensions. Ideally, these should be
the two longest dimensions in perpendicular directions, for example, the width and length of
the entire floor. It will not always be possible to place two tags along the total length or width
of a floor. That's OK. Place the tags in the biggest room or in a way that will allow you to grab a

long dimension.

Remember to take dimensions in perpendicular directions

It is advised to put additional tags in areas that will be visited more than once, like a hallway or
staircase. These won't necessarily be used for dimensional constraints, but the software will
recognize their location and use it to correct the overall geometry of the scan, in result
producing a more faithful 3D representation of the space.

You can, of course, put more tags and capture more than two dimensions per floor if you have

the time for the setup. You should avoid placing tags closer than 2 meters apart.
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Important!

Never place tags on doors or any other movable objects. Make sure the tag is securely

attached to the surface.

3. Choose a starting point

You should start and end your scan in the same place. This is to
ensure that the software can perform ,loop closure” - a way to
correct the little scanning errors that accumulate throughout the
scan. The starting point should also have a good depth variance -
you should definitely avoid starting pointing at a blank wall.

As a rule of thumb, the best place to start/end a scan is a corner,
i.e. where 3 perpendicular (or even just roughly perpendicular)
planes meet. It doesn't matter if there's furniture in view.

The best position to start/end is to position yourself in the “angular
center” of the corner, in other words: try to place the corner in the

center of your camera’s field of view.

very bad starting point - not enough .. two walls visible, icon starts turning good starting point - we're at the
planes detected, no detail visible green, but still not there yet... center of the angle and catch the
floor surface also

Pro-tip

The green circle around the start button will indicate if the area has enough distinct features

for the camera tracking to work properly.
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4. Scan the floor room by room

Try to capture the entire room, including the surface of the floor. Move around the room and
proceed to the next one.
Try not to leave too many gaps.

Leaving too many unscanned areas might make it difficult or impossible to figure out the proper room structure or

use. Try to capture the entirety of the space, including the floors.

5. Missed a spot? Append.

If after completing your scan you look at the preview and notice a missing room or a part of a
space use the append option to attach additional scan data.

Just hit the ,Scan/Append” button on the toolbar and choose a frame from the list of
thumbnails, which represent the places where you can resume the capture. You can only do
this in a spot that you have scanned previously. Then the app will display a semi-transparent
overlay showing the photo snapshot of the chosen frame. Move your device so that you are
aiming roughly at the same place, Dot3D will automatically recognize it when you're close
enough and resume scanning immediately.

Important!

Appending to a scan can only be done in the ,raw scan” stage, before the Optimization step
(see below).

10
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Best practice for the highest accuracy

For optimum results follow these general guidelines:

1. Avoid moving doors (at all cost)

Moving objects while scanning is one of the single most impactful causes of errors of mobile
3D scans. When capturing building interiors, the most common example of moving objects
are... doors.

You must use them to get around the place, but you should not move them during scanning.
This might pose a challenge, especially in small and cramped spaces, but with a bit of practice

you'll be able to strike a balance.
Remember to:

e Open all the doors in your space before starting the scan. If possible, fix them in place

with door-stoppers.

e Do not open or close any doors during the entire scanning process! This also includes

cabinet doors and moving objects in general

e If you notice a door was accidentally nudged or moved during the scan (or there was

no other way to get in and out of a tight space) try your best to avoid scanning the door
aqain. It is better to leave a gap in the scan in that area, rather than having a big break

of continuity.

11
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2. Keep a good distance from objects

e Tryto stay within 2-3 meters of distance from the walls. Of course, you can get closer
if detail is needed on a particular spot. However scanning large stretches at close
ranges (below 2 meters, especially. below 1.5 meters) can lead to overall subpar
results due to drift accumulation.

e A good rule of thumb is to treat walls as if they were mildly radioactive. You should
stay at a safe distance. You can get closer but only for short periods,

e Keep an even greater distance from white walls, as they can confuse the device's
self-positioning system by robbing it of visual signals. This can be really bad for overall
accuracy. If the space contains a lot of untextured/uncovered white walls, it's
particularly important not to scan them up close. White walls are best captured from a
3-4 meter distance. The goal is to get as much surrounding floor/ceiling/other walls
into the field of view as possible,

e |ncase of empty spaces with blank walls, it's a good practice to get some "stuff" into
the room: boxes, posters, or anything with geometry and/or texture. AprilTags on white
walls will help tremendously with providing anchor points for the scanner app,

e When moving through hallways, it's best to face the direction of the hallway and at a

45 angle toward the floor, to get good LiDAR depth coverage. Avoid facing the side
walls when moving through a hallway.

12
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3. Special situations
e Avoid scanning mirrors - just scan around them.
e Use the app’s built-in flash when scanning in dark spaces or corners (but remember to
turn it off later to save battery!)
e In case of very small rooms (toilets, storage cabinets, walk-in closets) it is
recommended to roughly scan the interior without going inside. The scan will have

some small gaps in the result, but that is OK. Moving around too much in small spaces
could sacrifice the overall accuracy of the entire scan.

4. Scanning path & movement

e Remember to always close the loop.

e Capture tags. When near a tag - capture it again. This is especially important when
closing a loop! Note that the app will indicate when it recognizes a tag by highlighting it
with a yellow square.

e Keep your movement steady, and avoid sudden changes of direction or rotation. Use
fluid motion, and avoid shaking or moving the device too fast, this can break the
continuity of the scan.

Pro-tip 1

Dot3D captures 3D points in ,bursts” every time the app detects a significant change in the
geometry overlap. Occasionally, the device might need a longer time to notice your movement.
In these cases you can trigger additional collection bursts manually by tapping anywhere on
the screen, other than on the action buttons. This way you can easily and quickly fill in the
gaps in the scan without extending the scanning path and moving the device too much.

Pro-tip 2

You can scan the interior and exterior of a property in one single
scan. To get the best results, place AprilTags near the doorway
leading out and on the sides of the windows which will be possible
to detect both from the inside and outside. These extra tags will
serve as ,anchors” between the two parts of the scan and vastly
improve the alignment.

13
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Fundamental scanning tips recap

Do not open or close any doors during the entire Instead, open - and fix in place - all the doors in
scanning process! your space before starting the scan.
Doors must stay in one position.
m If you notice a door was accidentally nudged
or moved during the scan try your best to avoid
scanning it again.

Do not stand close to walls while facing them. Instead, position yourself with a good amount of
Scanning walls up close deprives the camera of  distance to the walls. Get texture or geometry in
seeing important visual context. the camera'’s field-of-view.
Stay safel! Avoid scanning over Avoid scanning up close  Avoid scanning ceilings
Watch your step and blank areas (such as to objects, walls, furniture  unless you really need
always stand on solid blank walls) unless you truly need the  them in the model.
ground while scanning. detail. (but do include some
parts of the ceiling near
the walls)

These tips can be accessed in the Dot3D app from the scanning screen by hitting the "?" icon.

14
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Adding photos and annotations to the scan

The Dot3D app lets you grab HD photos while you are capturing the scan. This can be done
both manually and automatically.

Manual photo collection

It is a good idea to make photo snapshots in areas of interest, that are important but can be
not clearly visible in the 3D scan alone, e.g. an HVAC unit or cellar trap door.

To create a photo annotation simply click on the camera jgajf icon while making the scan.

These photos are saved with the point cloud data and can be later accessed along with their

location.

Automatic photo collection
You may also set your device to take photos automatically:
e (o to “Settings > Scene Capture > NeRF Settings”
e check ,Enable NeRF/PG Capture”
e set ,Frame Spacing”to,100".
This needs to be done just once. The app then remembers these settings and the photos are
collected for all subsequent scans.

The exported point cloud contains these photos
(collected manually and automatically) and their
location and orientation in space.

This feature proves useful when creating
as-built documentation - correctly placed photos
can clarify unclear areas of the scan.

Right: Mediatask’s software lets drafters quickly and contextually access all photos by hovering on the scan section.

You can also add custom Annotations to your scan - just press and hold the photo icon while
scanning and choose the crosshair icon. Later on, you can input additional text information, if
needed. This can be handy for adding important information that is not clearly visible on the
scan, such as the location of specific equipment (e.g. boiler or HVAC unit)

15
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Adding dimensions and optimizing the scan

After completing the scan, you will see an overlay text ,Model preview. Optimize to create the
final model”.

Important!

Before you proceed to Optimize, you should input the dimensional constraints first. It will not
be possible to do this after the optimization process.

To input measurements, click the , Targets” button on the menu. This will display a view of your

capture with a number near each recognized tag. Choose ,New Ref. Distance” (1) and then

press on two tags (2) (3) to specify which distance you want to input.

16
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Measure the distance between two tags with a laser distance meter and input the value into
the pop-up window. Be mindful that the app’s default units might vary from the units on your

laser measure. You can change this setting in Dot3D.

Repeat this process for all the dimensions in your scan. At this stage, it is good practice to
make sure all dimensions are properly placed.
Once you're done you can hit the ,Optimize” button in the toolbar:

Optimizing is done entirely on the device and is a crucial step that ensures maximum accuracy

of the data captured.

By providing Dot3D with reference measurements the app can adjust the point cloud in a way
that known dimensions are preserved and overall accuracy is improved. Additionally, the
AprilTags used for the dimensional constraints, as well as any additional ones present in the
scan serve the important purpose of identifying the fixed reference points in space - this is
used for the ,loop closure” algorithm which makes sure there are no shifts or breaks in the

point cloud.

17
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Review your scan

You're almost there, but we strongly recommend that you always perform a visual inspection
of your scan before exporting it. Choose the top-down view and switch to orthographic mode.
In this view, errors or problems are immediately more apparent than in the perspective view.
Check for:

1. Overall structural inteqrity:

There should not be any major breaks or misalignments visible in a properly optimized

scan.

Pro-tip: For additional clarity, use the
“Classic Point Clouds” option in the “Scene
Rendering” settings. It is a more
transparent view, which is especially
useful for checking the alignment
between two or more floors present in the

scan.

2. |fthe scanis properly oriented with regard to the vertical axis:

Top-down view: proper orientation - floors are If your scan appears rotated in the top-down
horizontal. view, you need to fix its orientation.

In the top-down view, the scan should look like a floor plan. On the rare occasion of a rotated
scan, please adjust the coordinate system as described in Example 4 below.

3. if the scan has been optimized and the dimensional constraints were entered:

In an already optimized scan you won't see the “Optimize” button in the top toolbar.
Next, click on “Targets”.
Blue lines should be visible for the dimensional constraints that you have put in.

18
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Saving and exporting

Your scans are stored by default in the Dot3D / Data folder on your device, but you should

make sure that you save any changes made before exiting the app.

Unsaved changes will be indicated by an orange dot in the top
left corner.

Choose File > Save to save changes. The app will also prompt
you to do so if you try to go back to the dashboard.

Dot3D lets you export the pointcloud in a variety of popular formats including pts, ply, and e57.
The native .dp format is recommended as it is lightweight and contains all the additional data
such as photos, annotations and control measurements. The format can be imported into the
most popular software, ranging from Autodesk Recap to CloudCompare (full list here Dot3D

workflows).

You also have the option to share the file directly with online storage apps e.g. Dropbox using
the Share/Export feature.

Uploading to Mediatask

If you're a Mediatask customer you can attach your scan(s) to an order for floor plan creation

or area measurement reports.
Simply upload the .dp file(s) to the “pointclouds” folder.*
The point cloud will be automatically pre-processed at this point. Within a minute you will see

its preview in the “Additional” folder, with each floor separate as a backdrop reference for

drafting.

*Alternatively you can paste a Dropbox or Google Drive link in the “pointclouds link” field.
I\ If you choose this option please make sure that the link points to a specific file (not a

folder) and that the “shared to anyone with link” option is turned on.

19
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Downstream Workflows

(a glimpse of how we make the most out of 3D scan data at Mediatask)

The automatically generated sections processed by Mediatask's proprietary software are
meant mainly for our drafters, but we invite our clients to inspect these images, as they show
in a clear and understandable way the structure of the building and can serve as a way to
double-check your work and input additional comments, useful for our drafters.

On the vertical section, you will see the
automatically detected floors, along with offset
lines at given heights (complying with local area
measuring rules, eg. 150cm for the NEN2580
and 5ft for the ANSI Z765 standard)

For each detected floor you will see a horizontal
section accompanied by its side views.

This backdrop is automatically placed in our
drafting software with proper scaling to eliminate
any errors and can be accessed at any time to
compare with the result model and floor plan.

There are also augmented sections, containing
all additional scan data, such as tags,
measurements and scan path, which we usefor
troubleshooting and customer training.

20
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At Mediatask we have built custom
scripts that let us leverage the richness
of the 3D data a Dot3D scan can
provide.

All annotations, both in text and photo
form, are displayed contextually in our
drafting software.

Our scripts also automatically create
panoramic 360 “hotspots”(—) which our

drafters (and clients!) can access to
double-check unclear areas in the scan.

With the proper scanning technique and a few days of training, even complex scans like the
one below can be achieved, in a fraction of the time it would take to measure by hand.

A Dot3D scan made by a client Floor plan created by Mediatask

21
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Troubleshooting

If you follow the guidelines described above, you should be able to get great results even on
your first scan.

However, some interiors might be harder to capture than others, there might be unexpected
situations that will lead to errors in the scan. Check to see if one of these common issues
applies to your scenario, if you have further questions or need additional assistance - please
don't hesitate to contact us!

Ex.1 “My scan is completely out of whack, what went wrong?”

When all parts of the scan look out of place, especially after optimization, it is very possible
that you have entered the wrong dimensional constraints or used the wrong units.

SOLUTION: Open the unoptimized scan, input the dimensions carefully, and run the
optimization again. To revert to the scan before optimization go to “File > Load Autosave.”

If you want to preserve the problematic scan you can also open the raw version separately:
Choose “File > Open” and navigate to the Dot3D folder on your device. All raw scans are in the
"Autosave” folder.

Scan with dimensions entered with the wrong units The same scan, but with units entered correctly this

(meters vs. millimeters) time

22
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Ex. 2 “Parts of the scan are in a completely wrong place”

This can happen if you enter the correct dimension, but assign it to the wrong pair of tags.
The app treats the user input with priority so it will try to adjust the scan to fit your entered
measurement. With an error like this, the task is impossible so part of the scan is displaced.

SOLUTION: Re-enter dimensions and optimize again.

Ex. 3 “Walls seem not to be straight” or “My scan seems a bit ‘wonky"”

Possible causes:
e doors opened/closed during scan - keep doors fixed in place and avoid rescanning
them if moved inadvertently

e staying too close to walls - make sure to follow the scanning tips displayed in Dot3D.
Keep a distance of 2-3 meters from walls and even more from entirely white/blank
walls,

e not making enough loops - without sufficient overlap in the scan the app has too few

“‘anchor points”.

SOLUTION: Follow the instructions on strategic target placement and make sure you close the
full loop, as well as secondary loops when revisiting scanned areas such as hallways or
common spaces

23



Mastering Mobile 3D Scanning

Ex. 4. “The scan is strangely rotated”

Your device is equipped with a gravity sensor so by default your scan should be properly
aligned: the (blue) “Z” axis should point “up” by default.

Very rarely the coordinate system may be rotated. You can adjust it by choosing Edit >
Coordinates and pressing the button marked “Primary”. You can then long press on a
horizontal surface, e.g. a floor, and dot3D will automatically adjust the coordinate system.

Press “Confirm’ and save your scan.

Wrong coordinate system (notice Z is not up) Correcting the Primary “Z” axis so it faces up

NOTE: You don't have to change the “X” and "Y” axes, we automatically rotate the scan to align

with the screen edges when you upload the scan to our portal.

Didn’t find what you were looking for?

We have tried to compile as much useful information as possible in this short guide to let you
master mobile 3D scanning. If you feel there is something missing or would like to suggest
changes - please get in touch with us at contact@mediatask.co !
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